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                                             Introduction to the Module 

 

A Database is information that is set up for easy access, management and updating. Computer databases typically 

store aggregations of data records or files that contain information, such as sales transactions, customer data, 

financials and product information. Databases are used for storing, maintaining and accessing any sort of data.  

This module is designed to meet the industry requirement under operate Database application occupational standard, 

particularly for the unit of competency: operate Database application 

This module covers the units: 

 Database objects 

 Basic Database settings  

 Forms 

 Information Retrieval  

 Reports 

 

Learning Objective of the Module 

 Create database objects 

 Customize basic settings  

 Create forms 

 Retrieve information  

 Create reports 

Module Instruction 

For effective use this module trainees are expected to read the module instruction shown below: 

1. Read the information written in each unit 

2. Accomplish the Self-checks at the end of each unit 

3. Perform Operation Sheets which were provided at the end of units  

4. Do the ―LAP test‖ giver at the end of each unit and 

5. Read the identified reference book for Examples and exercise 

https://www.techtarget.com/searchdatamanagement/definition/data
https://searchsqlserver.techtarget.com/definition/flat-file


           

Page 7 of 68 
 

Ministry of Labor and 
Skills 

Author/Copyright 

Operate Database Application Version -1 

August, 2022 

 

 

 

 

Unit one: Database Object 

This unit is developed to provide you the necessary information regarding the following content coverage and 

topics: 

 Introduction to Database 

 Basic design principles  

 Database object  

 Relationship    

 Record  

This unit will also assist you to attain the learning outcomes stated above. Specifically, upon completion of this 

learning guide, you will be able to: 

 Open  and design  data base using basic design principles 

 Create and modify Database object 

 Create relationship 

 Add, modify and delete records  

 Save and compile database objects  
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1.1. Basic Design Principle 

1.1.1. Database Design Principle  

Database design is the organization of data according to a database model. The designer determines what data must 

be stored and how the data elements interrelate. With this information, they can begin to fit the data to the database 

model. Database management system manages the data accordingly. Database design involves classifying data and 

identifying interrelationships. 

1.1.2. Basic principle  of database  

Usability: Any information which we are storing in any organization should be meaningful for that organization. If 

we are storing those factors which are actually not fit with organization’s requirement then this is just waste of 

resources. 

Extensibility: As we know that everyday new business requirements come up and every day there is a need to 

change or enhance information system to capture new requirements. So information design should be extensible so 

that it can adopt new requirements without much efforts or without major breaking changes. 

Data Integrity: Now at this point we understand that information is very much important for any organization. Based 

on the historic information, every organization makes different strategies, decisions for growth. One small mistake 

in data can lead to major issues with any organization’s key decision and hence a big risk for growth. 

Entity Integrity: Involves the structure (primary key and its attributes) of the entity. If the primary key is unique and 

all attributes are scalar and fully dependent on the primary key, then the integrity of the entity is good. In the 

physical schema, the table’s primary key enforces entity integrity. 

Domain Integrity: It defines that data should be of correct type and we should handle optional data in correct way. 

We should apply Nullability to those attributes which are optional for organization. We can define proper data types 

for different attributes based on organization’s requirement so that correct format data should present in system. 

Referential Integrity: This defines if any entity is dependent on another one then parent entity should be there in the 

system and should be uniquely identifiable. We can do this by implementing foreign keys. 

User defined integrity: There are few business rules which we cannot validate just by primary keys, foreign keys etc. 

There has to be some mechanism so that we can validate complex rules for integrity. We can implement these rules 

in following ways: 

Performance: As we know that information should be readily available as requested. Performance of the system 

should be up to the mark. As data in increasing day by day so at some time there will be impact on performance if 

database design is poor or we’ll not take any actions to improve performance. 

Availability: The availability of information refers to the information’s accessibility when required regarding 

uptime, locations, and the availability of the data for future analysis. Disaster recovery, redundancy, archiving, and 

network delivery all affect availability. 

Security: For any organizational asset, the level of security must be secured depending on its value and sensitivity. 

Sometime organizations have suffered a lot because of data leaks which results in loss of faith and tends to business 

risk. So security is one of the most important aspect of good database design. 

1.2. Open & Design Database Application 

A database can best be described as a way of storing large amounts of information.  

The data can be retrieved and we can even ask questions of the data and get answers. For example: You may want to 

know how many Students enrolled in every occupational level. 

https://en.wikipedia.org/wiki/Database_model


           

Page 9 of 68 
 

Ministry of Labor and 
Skills 

Author/Copyright 

Operate Database Application Version -1 

August, 2022 

 

MS Access (MS Office Access ) is a database management tool that enables one to store relevant data.   

This also has the capabilities to retrieve, sort, summarize report and result immediately and effectively.  

It can combine data from various files (tables) through creating relationships and can make data entry more efficient 

and accurate through the use of forms. 

Microsoft Access (MS Access) enables to manage all important information from a single database file, Within the 

file can use the different objects/items: 

1.2.1. Design process 

Determine the purpose of your database.    This helps prepare you for the remaining steps. 

Find and organize the information required. Gather all of the types of information you might want to record in the 

database, such as product name and order number. 

Divide the information into tables. Divide your information items into major entities or subjects, such as Products or 

Orders. Each subject then becomes a table. 

Turn information items into columns. Decide what information you want to store in each table. Each item becomes a 

field, and is displayed as a column in the table. For example, an Employees table might include fields such as Last 

Name and Hire Date. 

Specify primary keys. Choose each table’s primary key. The primary key is a column that is used to uniquely 

identify each row. An example might be Product ID or Order ID. 

Set up the table relationships. Look at each table and decide how the data in one table is related to the data in other 

tables. Add fields to tables or create new tables to clarify the relationships, as necessary. 

Refine your design. Analyze your design for errors. Create the tables and add a few records of sample data. See if 

you can get the results you want from your tables. Make adjustments to the design, as needed. 

Apply the normalization rules. Apply the data normalization rules to see if your tables are structured correctly. Make 

adjustments to the tables, as needed. 

1.3. Database Objet 

A database object is any defined object in a database that is used to store or reference data. Anything which we 

make from create command is known as Database Object. It can be used to hold and manipulate the data.  

A database object in a relational database is a data structure used to either store or reference data.  

When a database object is created, a new object type cannot be created because all the various object types created 

are restricted by the very nature, or source code, of the relational database model being used, such as Oracle, SQL 

Server or Access. What is being created is instances of the objects, such as a new table, an index on that table or a 

view on the same table.  

 

 

 

 

1.3.1. Type of Database objects 

Metadata – is a “data about data” or synonymously called table structure that defines what type of data your data is.   

Tables - A table is a collection of data about a specific topic, such as products or suppliers recently, we define it as a 

file but technically it was defined as a container or a worksheet-like container where the collection of data has been 

stored. 

Basic Component of a Table: 
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 Meta Data – Database Structure 

 Field – Column – Data 

 Fieldname 

 Record - Row – Information 

Queries –Queries used to view, change, and analyze data in different ways. You can also use them as a source of 

records for forms, reports. 

Forms - A form is a type of a database object that is primarily used to enter or display data in a database. You can 

also use a form as a switchboard that opens other forms and reports in the database, or as a custom dialog box that 

accepts user input and carries out an action based on the input.  

Reports - A report is an effective way to present your data in a printed format.  

1.4. Create Data base Objects 

The most common object that people interact with is the table. Other objects are indexes, stored procedures, 

sequences, views and many more.  Anything which we make from create command is known as Database Object. It 

can be used to hold and manipulate the data. Before we proceed to creating your first table, you need to know the 

basic components of a table: 

 

Meta Data – Database Structure 

Field – Column – Data 

Fieldname 

Record - Row – Information 

 

Designing table involves 

Entering unique names of the columns of the table in the ―field name” column of the design view.  

Names of fields and objects in Microsoft Access can be up to 64characters long.  

They can include any combination of letters, numbers, spaces, and special characters except a period (.), an 

exclamation point (!), an accent grave (`), and brackets ([ ]). They also can't begin with leading spaces 

1.4.1.  Data types in Microsoft Access 

An Access database stores its tables in a single file, along with other objects, such as forms, reports, macros, and 

modules. 

The different kinds of Ms Access data types are:  

Text: allows for the storage of any kind of data, characters, digits and special characters.  

Memo: is used for texts of more than 255 characters such as comments or explanations.  

Number: for numerical data used in mathematical calculations.  

Date/Time: for the introduction of date and time from the year 100 to 9999. 

Currency: For monetary/economic values and numerical data used in mathematical calculations in which the data 

involved contains between one and four decimals.  

Auto number: a unique sequential number (increasing one by one), or a number that Access assigns every time it 

adds a new record to a table.  

Yes/No:Yes and No values, and fields that contain one of two values (Yes/No, True/False or 

Activated/Deactivated). 
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OLE Object: an object such as a Microsoft Excel spreadsheet, a Microsoft Word document, graphics, images, 

sounds, or other binaries. 

Used to embed or link to documents from other programs like Excel and Word. 

Hyperlink: text or a combination of text and numbers stored as text and used as a hyperlink address.  

Attachment: Used to store files in an Access database.  

The attachment data type lets you store one or more files per record. 

Lookup wizard…: A lookup wizard field lets the user choose from a predefined set of options, like a "male" or 

"female" selection or a "country" selection.  

1.4.1. Normalization  

Normalization is the process of organizing data in a database. This includes creating tables and establishing 

relationships between those tables according to rules designed both to protect the data and to make the database 

more flexible by eliminating redundancy and inconsistent dependency. It is also the process of efficiently organizing 

data in a database. 

 Goal of Normalization process 

Eliminating redundant data (for example, storing the same data in more than one table)  

 Ensuring data dependencies make sense (only storing related data in a table). Both used to reduce the amount of 

space a database consumes and ensure that data is logically stored. 

1.5. Modify Data Base object 

Every template that is included with Access is a complete tracking application that contains predefined tables, 

forms, reports, queries, macros, and relationships. These templates are designed to be immediately useful out-of-the-

box, so that you can create a new database that is based on a template and get up and running quickly. However, 

there might be times when you want to modify your new database — for example, to add or rename a field, or 

change a report. You can easily add a field to a table in Datasheet view. However, you can also add a field to a table 

in Design view. To learn more about adding a field to a table in Datasheet view, see the article Add or delete a 

column in a datasheet. When you add a new field to a table, the field is not automatically added to your existing 

forms and reports. You must manually add the field to those forms and reports in order for it to appear in them. 

If possible, you should avoid deleting a field from a database that was generated from one of the supplied 

templates — it is likely that the field is employed in other database objects, such as forms and reports. Thus, deleting 

the field will create consequences when you attempt to use the other database objects that employ the field — the 

database objects will not work as expected. You will have to remove any references to the field from all of the 

objects that employ it in order for those other objects to work correctly. 

When you decide that you must delete a field from a database that was generated from a template, you can do so in 

either Datasheet view or Design view. Remember that if other database objects reference the deleted field, you must 

modify those other objects to remove the reference. For example, if a report includes a control that is bound to the 

deleted field and you run the report, an error message appears, because Access cannot find the data for the field. 

Before you can delete a field, you must ensure that it doesn't participate in any table relationships. If you try to 

delete a field for which relationships exist, Access warns you that you must first delete the relationships. 

 

http://en.tekstenuitleg.net/articles/software/access-data-types#attachment-data-type
http://databases.about.com/library/glossary/bldef-table.htm
http://databases.about.com/od/specificproducts/a/Database-Dependency.htm
https://support.office.com/en-us/article/add-or-delete-a-column-in-a-datasheet-02064e10-3fd7-4377-8034-c6f75dc5a12c
https://support.office.com/en-us/article/add-or-delete-a-column-in-a-datasheet-02064e10-3fd7-4377-8034-c6f75dc5a12c
https://support.office.com/en-us/article/add-or-delete-a-column-in-a-datasheet-02064e10-3fd7-4377-8034-c6f75dc5a12c
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1.6. Data base Relationship 

Are associations between tables that are created using join statements to retrieve dta.  Each primary key value relates 

to none or only one record in the related table. Most one-to-one relationships are forced by business rules and do not 

flow naturally from the data. New comers to the world of databases often have a hard time seeing the differences 

between a database and a spreadsheet.  

See tables of data and recognize that databases allow you to organize and query data in new ways, but fail to grasp 

the significance of the relationship that gives relational database technology& its name.  

Allow you to describe the connections between different database tables in powerful ways.  

Once you’ve described the relationships between your tables, you can later leverage that information to perform 

powerful cross-table queries, known as joins. 

Is a logical connection between two tables . 

One of the huge advantages of a relational database is that, once you have your data held in clearly defined, compact 

tables, you can connect or relate the data held in different tables. 

1.6.1. Types of key 

Keys are fields that are part of a table relationship. There are two kinds of keys 

Primary key 

 A primary key is used to identify each record that you store in the table.  

 It will not allow a duplication of the Primary Key thus make it unique.   

 A table can have only one primary key.  

 Primary Key is the unique identification of one record. There is a uniquely identification number, such as: 

ID number, serial number and code that serves as a primary key 

Foreign Key 

A table can also have one or more foreign key.  

A foreign key contains values that correspondent to values in the primary key of another table 

use table relationship to combine data from related table 

 

 

  

 

 

 

 

 

 

Primary key                                                

 

 

 

            

                                                            Foreign key 

 

1.6.1. Types of Database Relationships 

 One-to-one relationships: occur when each entry in the first table has one, and only one, counterpart in the 

second table.  

 One-to-many relationships: Is the most common type of database relationship. 

 Many-to-many relationships: occur when each record in the first table corresponds to one or more records 

in the second table and each record in the second table corresponds to one or more records in the first table.  

ER Diagram (Entity Relationship Diagram) 

Customer 

c-id 

c-name 

c-age 

c-sex 

c-phone 

c-address 

Employee  

e- id 

e- name 

e- age 

e- sex 

e- address 

e- salary 

c-id 



           

Page 13 of 68 
 

Ministry of Labor and 
Skills 

Author/Copyright 

Operate Database Application Version -1 

August, 2022 

 

 An Entity Relationship Diagram (ERD) is a visual representation of different data using conventions that describe 

how these data are related to each other. For example, the elements writer, novel, and consumer may be described 

using ER diagrams this way: 

 

 

 In the diagram, the elements inside rectangles are called entities while the items inside diamonds denote the 

relationships between entities.  

ER Diagrams Usage 

ER diagrams are most often associated with complex databases that are used in software engineering and IT 

networks.  

In particular, ER diagrams are frequently used during the design stage of a development process in order to identify 

different system elements and their relationships with each other. For example, inventory software used in a retail 

shop will have a database that monitors elements such as purchases, item, item type, item source and item price. 

Rendering this information through an ER diagram would be something like this: 

 

 

 

 

 

 

In the diagram, the information inside the oval shapes is attributes of a particular entity. 

  ER Diagram Symbol and Notations 

 

Figure 3 ER Diagram Symbol and Notations 

 

Elements In ER Diagram 

Entity 

An entity can be a person, place, event, or object that is relevant to a given system.  

For example, a school system may include students, teachers, major courses, subjects, fees, and other items.  

Entities are represented in ER diagrams by a rectangle and named using singular nouns. 

Attribute 

An attribute is a property, trait, or characteristic of an entity, relationship, or another attribute.  

For example, the attribute Inventory Item Name is an attribute of the entity Inventory Item. An entity can have as 

many attributes as necessary.  

Meanwhile, attributes can also have their own specific attributes. For example, the attribute ―customer address‖ can 

have the attributes number, street, city, and state. These are called composite attributes.  

Note that some top level ER diagrams do not show attributes for the sake of simplicity.  

In those that do, however, attributes are represented by oval shapes. 

Figure 1 Entity Relationship Diagram 

Figure 2 ER Diagrams Usage 
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Attributes in ER diagrams, note that an attribute can have its own attributes (composite attribute) 

 

 

                     Relationship 

A relationship describes how entities interact. For example, the entity ―carpenter‖ may be related to the entity 

―table‖ by the relationship ―builds‖ or ―makes‖.  

Relationships are represented by diamond shapes and are labeled using verbs. 

 

 

 

There are more elements which are based on the main elements. These are: 

Weak Entity 

A weak entity is an entity that depends on the existence of another entity.  

In more technical terms it can defined as an entity that cannot be identified by its own attributes.  

It uses a foreign key combined with its attributed to form the primary key.  

An entity like order item is a good example for this. The order item will be meaningless without an order so it 

depends on the existence of order. 

 

Figure 6 Using Relationships in Entity Relationship Diagrams 

 

Multi valued Attribute 

If an attribute can have more than one value it is called a multivalued attribute. 

It is important to note that this is different to an attribute having its own attributes. For example a teacher entity can 

have multiple subject values. 

 

Figure 7Example of a multi valued attribute 

Derived Attribute 

An attribute based on another attribute.  

 is found rarely in ER diagrams.  

For example for a circle the area can be derived from the radius. 

 

 

Figure 8 Derived Attribute in ER diagrams 

Recursive Relationship 

If the same entity participates more than once in a relationship it is known as a recursive relationship.  

In the below example an employee can be a supervisor and be supervised, so there is a recursive relationship. 

Figure 4  Example of Entity and Attribute 

Figure 5 Using Relationships in Entity Relationship Diagrams 
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Figure 9 Example of a recursive relationship in ER diagrams 

Cardinality and ordinarily are two other notations used in ER diagrams to further define relationships. 

These two further defines relationships between entities by placing the relationship in the context of numbers.  

In an email system, for example, one account can have multiple contacts.  

The relationship in this case follows a ―one to many‖ model.  

There are number of notations used to present cardinality in ER diagrams.  

 

ER Diagram Template 

 ERD templates can be edited and adjusted to fit into your work, regardless of industry. This entity-relationship 

diagram template will help you organize databases and information systems efficiently, highlighting vital 

relationships developed between a system’s components. 

 

 

Figure 10  ER Diagram Template of exam database 

 

Benefit of ER Diagram 

Constitute a very useful framework for creating and manipulating databases.  

Are easy to understand and do not require a person to undergo extensive training to be able to work with it 

efficiently and accurately. 

Designers can use ER diagrams to easily communicate with developers, customers, and end users, regardless of their 

IT proficiency. 

Are readily translatable into relational tables which can be used to quickly build databases.  

Can be directly used by database developers as the blueprint for implementing data in specific software applications. 

May be applied in other contexts such as describing the different relationships and operations within an 

organization. 
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1.7. Record 

There are several ways to update data in an Access database. You add a record to your database when you have a 

new item to track, such as a new contact to the Contacts table. When you add a new record, Access appends the 

record to the end of the table. You also change fields to stay up-to-date, such as a new address or last name. To 

maintain data integrity, the fields in an Access database are set to accept a specific type of data, such as text or 

numbers. If you don't enter the correct data type, Access displays an error message. Finally, you can delete a record 

when it is no longer relevant and to save space. 

You use a form to manually update data. Data entry forms can provide an easier, faster, and more accurate way to 

enter data. Forms can contain any number of controls such as lists, text boxes, and buttons. In turn, each of the 

controls on the form either reads data from or writes data to an underlying table field. 

 

Datasheets are grids of data that look like Excel worksheets. You can change data by working directly in Datasheet 

view. If you are familiar with Excel, datasheets should be relatively easy to understand. You can change data in 

tables, query result sets, and forms that display datasheets. Typically, you use datasheets when you need to see many 

records at once. 

 

 

 

Understanding data entry symbols 

 

The following table shows some of the record selector symbols you might see when updating data and what they 

mean. 

Symbol  Meaning  

 

This is the current record; the record has been saved as it appears. The current record is indicated by a 

change in color in the record selector. 

 

You are editing this record; changes to the record aren't yet saved. 

 

This record is locked by another user; you can't edit it. 

 

This is a new record in which you can enter information. 

 

This is the primary key field and contains a value that uniquely identifies the record. 
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Self check-1 

Test I. Matching 

Instruction: Instruction: select the correct answer for the give choice. You have given 1 Minute for each question. 

Each question carries 2 Point. 

 

Test II. True/ False 

Instruction: Say true or false the following question .You are provided 3 minute for each question and each point has 

3Points 

1. Field is the component of table. 

2. Number allows for the storage of any kind of data, characters, digits and special characters. 

3. Before you can delete a field, you must ensure that it doesn't participate in any Table relationships  

Note: Satisfactory rating – above 60%           Unsatisfactory - below 60% 

You can ask you teacher for the copy of the correct answers 

 

 

 

 

Operation Sheet 1.1. DB application and principles 

 Operation title: Opening  and designing DB application 

 Purpose: To create and open DB application 

 Instruction: Using the given application software (ms access) create and open database. You have given 

30Minut for the task and you are expected to create database. 

 Tools and requirement: 

1. Personal computer  

2. Microsoft office 

 Steps to doing the task 

A B 

………..1. Domain integrity A. Refers to the information’s accessibility 

………..2. Availability B. The unique identification of one record 

………..3. Text C. Defines that data should be of correct type 

………..4. ER D. Visual representation of different data 

………..5.Primary key E.: Allows for the storage of any kind of data 

 F. An attribute based on another attribute 

G. Database application 
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On the Getting Started with Microsoft Office Access page, under New Blank Database, click Blank 

Database. 

 

 

1. In the Blank Database pane, type a file name in the File Name box. If you do not supply a file name 

extension, Access adds it for you. To change the location of the file from the default, click Browse for a 

location to put your database  (next to the File Name box), browse to the new location, and then 

click OK. 

2. Click Create. 

3. Access creates the database with an empty table named Table1, and then opens Table1 in Datasheet view. 

The cursor is placed in the first empty cell in the Add New Field column. 

4. Begin typing to add data, or you can paste data from another source, as described in the section Copy data 

from another source into an Access table. 

 

 Steps to doing the task 

1. Click the Microsoft Office Button ,  

2. Click Open. In the Open dialog box, browse to the database that you want to open. 

3. Double-click the database to open it in the default mode specified in the Access      

4. Options dialog box or the mode that was set by an administrative policy. 

5. Click Open to open the database for shared access in a multi-user environment so that you and other users 

can read and write to the database. 

6. Click the arrow next to the Open button and then click Open Read-Only to open the database for read-only 

access so that you can view but not edit it. Other users can still read and write to the database. 

7. Click the arrow next to the Open button  

8. Click Open Exclusive to open the database with exclusive access. When you have a database open with 

exclusive access, anyone else who tries to open the database receives a "file already in use" message. 

 Quality Criteria: create and open database 

 Precautions: OHS  

Operation Sheet 1.2.  Database Objects (Tables) 

 Operation title: Creating Database object 

 Purpose: To create and access and customize  table with different option 

 Instruction: Using the given application software (ms access) create database object table. You have given 

30Minut for the task and you are expected to create database  

 Tools and requirement: 

1. Personal computer 

2. Microsoft office(ms access application) 

 Steps to Create a new table in a new database 

1. Click the Microsoft Office Button , and then click New. 

http://office.microsoft.com/en-us/access-help/create-a-new-database-HA010037837.aspx#BMpastedata
http://office.microsoft.com/en-us/access-help/create-a-new-database-HA010037837.aspx#BMpastedata
http://office.microsoft.com/en-us/access-help/create-a-new-database-HA010037837.aspx#BMpastedata
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2. In the File Name box, type a file name for the new database. 

3. To browse to a different location to save the database, click the folder icon. 

4. Click Create. 

 Steps to Create a new table in an existing database 

1. Click the Microsoft Office Button , and then click Open. 

2. In the Open dialog box, select the database that you want to open, and then click Open. 

3. On the Create tab, in the Tables group, click Table. 

 Steps to Create a new table by using a table template 

1. Click the Microsoft Office Button , and then click Open. 

2. In the Open dialog box, select and open the database in which you wish to create a table. 

3. On the Create tab, in the Tables group, click Table Templates and then select one of the available templates 

from the list. 

 

 Steps to Create a new table by importing or linking to external data 

1. Click the Microsoft Office Button , and then click Open. 

2. In the Open dialog box, select and open the database in which you wish to create a new table. 

3. On the External Data tab, in the Import group, click one of the available data sources. 

 
1. Follow the instructions in the dialog boxes that appear at each step. 

 Steps to Use a SharePoint site to create a table 

1. Click the Microsoft Office Button , and then click Open. 

2. In the Open dialog box, select the database in which you want to create the new table, and then 

click Open. 

3. On the Create tab, in the Tables group, click SharePoint Lists. 

 Steps to Create a SharePoint list that is based on a template 

1. Click either Contacts, Tasks, Issues, or Events. 

2. In the Create New List dialog box, type the URL for the SharePoint site where you want to create the list. 

3. Enter a name for the new list and its description in the Specify a name for the new list and 

Description boxes. 

4. To open the linked table after it is created, select the Open the list when finished check box (selected by 

default). 

 Steps to Create a new custom list 

1. Click Custom. 

2. In the Create New List dialog box, type the URL for the SharePoint site where you want to create the list. 

3. Enter a name for the new list and its description in the Specify a name for the new list and 

Description boxes. 

4. To open the linked table after it is created, select the Open the list when finished check box (selected by 

default). 

 Steps to import the data from an existing list 

1. Click Existing SharePoint List. 



           

Page 20 of 68 
 

Ministry of Labor and 
Skills 

Author/Copyright 

Operate Database Application Version -1 

August, 2022 

 

2. In the Get External Data dialog box, type the URL for the SharePoint site that contains the data that you 

want to import. 

3. Click Import the source data into a new table in the current database, and then click Next. 

4. Select the check box next to each SharePoint list that you want to import. 

 Steps to Link to an existing list 

1. Click Existing SharePoint List. 

2. In the Get External Data - SharePoint Site dialog box, type the URL for the SharePoint site that contains 

the list to which you want to link. 

3. Click Link to the data source by creating a linked table, and then click Next. 

4. Select the check box next to each SharePoint list to which you want to link. 

 Steps to set or change  a table's primary key 

1. Select the table whose primary key you want to set or change. 

2. On the Home tab, in the Views group, click View, and then click Design View. 

3. In the table design grid, select the field or fields that you want to use as the primary key. 

4. On the Design tab, in the Tools group, click Primary Key. 

5. A key indicator appears to the left of the field or fields that you specify as the primary key. 

 Steps to Remove the primary key 

1. Select the table whose primary key you want to remove. 

2. On the Home tab, in the Views group, click View, and then click Design View. 

3. Click the row selector for the current primary key. If the primary key consists of multiple fields, hold down 

CTRL, and then click the row selector for each field. 

4. On the Design tab, in the Tools group, click Primary Key. 

 Steps to Set a table's properties 

1. Select the table whose properties you want to set. 

2. On the Home tab, in the Views group, click View, and then click Design View. 

3. On the Design tab, in the Show/Hide group, click Property Sheet.The table property sheet is shown. 

4. On the property sheet, click the General tab. 

5. Click the box to the left of the property that you want to set, and then enter a setting for the property. 

6. To save your changes, press CTRL+S. 

 

 Steps to Add a field by using a field template 

1. On the Home tab, in the Views group, click View, and then click Datasheet View. 

2. On the Datasheet tab, in the Fields & Columns group, click New Field. 

3. Select one or more fields in the Field Templates pane, and then drag them to the table where you want to 

insert the new column. 

 Steps to Rename a field 

1. Right-click the heading of the field that you want to rename (for example, Field1). 

2. On the shortcut menu, click Rename Column. 

3. Enter the new name in the field heading. 

 Steps to Set other field properties 

1. In Datasheet view, click the field for which you want to set the property. 

2. On the Datasheet tab, in the Data Type & Formatting group, select the properties that you want. 

 Steps to Set field properties in Design view 

1. Open a table in Design view 

2. In the Navigation Pane, right-click the table. 

3. On the shortcut menu, click Design view. 

 Change a field's data type 

 In the table design grid, locate the field for which you want to set the data type. 

 In the Data Type column, choose a data type from the list. 

To save your changes, press CTRL+S. 

 Quality Criteria: create table 

 Precautions: OHS   

 

 

Operation sheet 1.3. Modify Database Objects 

 Operation title: modifying Database object 

 Purpose: To rename  a Database object Table 

javascript:AppendPopup(this,'178078404_6')
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 Instruction: Using the given application software (ms access) modify database object table. You have given 

30Minut for the task and you are expected to create database  

 Tools and requirement: 

1. Personal computer  

2. Microsoft office 

 Steps to turn on the Name AutoCorrect option 

1. Click File>Options.  

2. In the Access Options dialog box, in the left pane, click Current Database. 

3. Under Name AutoCorrect Options, select the Track name AutoCorrect info check box, and then select the 

Perform name AutoCorrect check box. 

4. If you want to keep a table that logs each change that is performed by Name AutoCorrect, select the Log 

name AutoCorrect changes check box. 

5. Click OK. 

6. To save your changes, click Save on the Quick Access Toolbar. 

 Steps to rename a field in Datasheet view 

1. In the Navigation Pane, double-click the table in which you want to rename the field. 

2. Right-click the column heading for the field that you want to rename, and then click Rename Field on the 

shortcut menu. 

3. Type the new name for the field and then press ENTER. 

 Steps to rename a field in Design view 

1. In the Navigation Pane, right-click the table in which you want to rename the field, and then click 

Design View on the shortcut menu.. 

2. Click the cell in the Field Name column for the field that you want to rename. 

3. Edit the text to rename the field. 

4. To save your changes, click Save on the Quick Access Toolbar. 

 Steps to rename a table 

1. In the Navigation Pane, right-click the table that you want to rename and then click Rename on the shortcut 

menu. 

2. Type the new name and then press ENTER. 

3. To save your changes, click Save on the Quick Access Toolbar 

Quality Criteria: rename database object table 

Precautions: OHS  

 

 Operation sheet 1.4.  Database Relationship 

 Operation title: creating Database relationships 

 Purpose: To create relationships 

 Instruction: Using the given application software (ms access) Create relationship. You have given 30Minut 

for the task and you are expected to create relation ship between tables. 

 Tools and requirement: 

1. Personal computer  

2. Microsoft office 

 Steps to Create a table relationship  

 

1. Click the Database Tools tab. 

2. Click the Relationships button. 
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3. Click the Show Table button 

4. Double-click the table(s) you want to add. 

5. Click Close 

 

 
6. Click the related field in the first table and drag it to the related field in the second table. 

Whenever you link a primary key from one table to a field from another table, you create a foreign key. 

 

 
7. Check the Enforce Referential Integrity option (optional). 

Click Create 

 

Steps to delete a table relationship 

1. Click the join line that connects the tables 

2. Press the Delete key. Access asks you to confirm that you really want to delete the relationship. 

3. Click Yes. 

 

 Steps to print relationship window 

1. Click the Database Tools tab. 

2. Click the Relationships button 

 



           

Page 23 of 68 
 

Ministry of Labor and 
Skills 

Author/Copyright 

Operate Database Application Version -1 

August, 2022 

 

 

 

3. Click the Relationship Report button. 

 

 
4. Click the Print button. 

The Print dialog box appears. 

5. Select the desired print settings and click OK. 

The Relationships report is printed. 

6. Click the Close Print Preview button. 

 
 

7. Click the Relationships report's Close button. 
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Quality Criteria: create database relationship 

Precautions: OHS  

 

 

 

 

 

 

 

 

 

 

 

 

 

LAP Test Practical Demonstration 

Name: __________________________                                Date: ____________ 

Time started: ____________________             Time finished: _______________ 

Instruction I: Given necessary templates, tools and materials you are required to perform the following tasks within 

2 hours. 

Task-1: Create a new database, save it on the desktop and name it "School Database" 

Task-2: Create a Table in the School Database with the following 

Field Name Data Type Field Size or Format 

ID  Number Text 

10 Name Text 

15 Surname Text 

15 Telephone Number Number 

Long Integer Date of Birth Date/Time 

Medium Date Stipend Currency 

Currency Foreigner Yes/No 

Task-3: open the <<student table>> and enter 5 complete record. 

 

 

 

 

 



           

Page 25 of 68 
 

Ministry of Labor and 
Skills 

Author/Copyright 

Operate Database Application Version -1 

August, 2022 

 

 

 

 

Unit Two:  Customize basic settings 

This unit to provide you the necessary information regarding the following content coverage and topics: 

 Setting  page layout  

 Database  toolbars  

 Fonts 

This guide will also assist you to attain the learning outcomes stated in the cover page. Specifically, upon 

completion of this learning guide, you will be able to: 

 Adjust  page layout  

 Open and view different toolbars  

 Format Fonts 
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2.1. Understanding layout view 

Layout view is the most intuitive view to use for report modification, and can be used for nearly all the changes you 

would want to make to a report in Access. In Layout view, the report is actually running, so you can see your data 

much as it will appear when printed. However, you can also make changes to the report design in this view. Because 

you can see the data while you are modifying the report, it's a very useful view for setting column widths, add 

grouping levels, or performing almost any other task that affects the appearance and readability of the report. 

  

2.2. View Database tool 

Toolbar Sometimes referred to as a bar or standard toolbar, the toolbar is a row of boxes, often at the top of an 

application window, that control various functions of the software. The boxes often contain images that correspond 

with the function they control, as demonstrated in the image below. 

 

Figure 11 Database Toolbar 

A toolbar often provides quick access to functions that are commonly performed in the program. For example, a 

formatting toolbar in a Microsoft Access  gives you access to things like making text bold or changing its alignment, 

along with other common buttons 

Common computer software toolbars  

 Commands bar - A bar that shows available commands in a program. 

 Formatting toolbar - Toolbar that shows text formatting options. 

 Formula bar - Bar in a spreadsheet program that allows you to edit a formula. 

 Menu bar - A bar at the top of the screen that gives access to all of the menus. 

 Navigation bar - Gives access to all navigation features in a browser. 

 Places bar - A pane that shows common places to access files. 

 Scroll bar - A bar on the bottom or side of the window to scroll through a page. 

Split bar - A bar that divides the window into multiple sections. 

https://www.computerhope.com/jargon/s/software.htm
https://www.computerhope.com/jargon/p/program.htm
https://www.computerhope.com/jargon/f/formatting-toolbar.htm
https://www.computerhope.com/comp/msoft.htm
https://www.computerhope.com/jargon/b/bold.htm
https://www.computerhope.com/jargon/b/button.htm
https://www.computerhope.com/jargon/c/commabar.htm
https://www.computerhope.com/jargon/f/formatting-toolbar.htm
https://www.computerhope.com/jargon/f/formulab.htm
https://www.computerhope.com/jargon/m/menubar.htm
https://www.computerhope.com/jargon/n/navbar.htm
https://www.computerhope.com/jargon/p/placesba.htm
https://www.computerhope.com/jargon/s/scrollba.htm
https://www.computerhope.com/jargon/s/splitbar.htm
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Status bar - One of the few bars at the bottom of the window that shows the status. 

Title bar - A bar at the very top of a window that describes the program or window 

 

2.3. Fonts 

A font is a graphical representation of text that may include a different typeface, point size, weight, color, or design. 

The image shows some examples of different computer fonts. Software programs like Microsoft Word, Microsoft 

Excel, and Ms-access allow users to change the font used when typing text in the document or spreadsheet, as do 

web designers. Formatting Fonts Sometimes users want to specify or change the appearance of a group of words or 

characters, or even of a single word or character, and they are not familiar enough with all of Word's font formatting 

options to know how to achieve the effect that they are seeking. Although most users are probably familiar with 

some different font families and sizes and with the italic and bold typefaces, many users do not know how to 

determine and apply the settings that are needed to add a colored background to their text or to type 

 

 

 

 

Self check 2 

Instruction:   Answer all the questions listed below. You have given 1 Minute for each question. Each question 

carries 2 Point. 

1. Which View  is the most intuitive view to use for report modification  

A. Design view 

B. Lay out view 

C. A&B 

D. None 

2. Layout view is useful for  

A. setting column widths 

B.  add grouping levels 

C.  performing almost any other task 

D. All of the above 

3.  A bar that shows available commands in a program. 

A. Commands bar 

B. Menu bar 

C. Title Bar 

4. Toolbar that shows text formatting options. 

A. Formatting toolbar  

B. Command bar 

C. Status bar 

5. ……….is a graphical representation of text  

A. Font 

B. Lay out view 

C. A&B 

D. None 

Test II: short Answer writing 

https://www.computerhope.com/jargon/s/statusbar.htm
https://www.computerhope.com/jargon/t/titlebar.htm
https://www.computerhope.com/jargon/t/typeface.htm
https://www.computerhope.com/jargon/p/point.htm
https://www.computerhope.com/jargon/m/microsoft-word.htm
https://www.computerhope.com/jargon/e/excel.htm
https://www.computerhope.com/jargon/e/excel.htm
https://www.computerhope.com/jargon/e/excel.htm
https://www.computerhope.com/jargon/c/commabar.htm
https://www.computerhope.com/jargon/f/formatting-toolbar.htm
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Instruction: write short answer for the given question. You are provided 3 minute for each question and each point 

has 5Points  

1. What is font? 

2. Write down at least 3 database toolbar. 

Note: Satisfactory rating – above 60%           Unsatisfactory - below 60% 

You can ask you teacher for the copy of the correct answers 

 

 

Operation Sheet 2.1. Settings layout 

 Operation title: Adjust page layout  

 Purpose: To practice  and adjust page layout  

 Instruction: Using the given application software (ms access) to adjust a page payout. You have given 

15Minut for the task and you are expected to adjust page layout. 

 

 Tools and requirement: 

1. Personal computer  

2. Microsoft window(ms-access application) 

 Steps to Change page setup 

1. Click the Page Setup tab. 

2. In the Page Size group, click Size to select a different paper size. 

3. In the Page Size group, click Margins to make adjustments to the report's margins. 

4. In the Page Layout group, click Portrait or Landscape to change the paper orientation. 

 Quality Criteria: set layout 

 Precautions: OHS  

Operation Sheet 2.2. Toolbars 

 Operation title: customize Toolbars 

 Purpose: To open and view toolbars 

 Instruction: Using the given application software (ms access) to customize a dataase toolbar. You have 

given 30Minut for the task and you are expected to customize a database toolbar. 

 Tools and requirement: 

1. Personal computer 

2. Microsoft Window  

 Steps to create a new toolbar 

1. On the View menu, point to Toolbars, and then click Customize. 

2. Click the Toolbars tab, and then click New. 

3. In the Toolbar Name box, type a name for your new custom toolbar. 

4. In the Make toolbar available to box, click the template or open document where you want to store the 

toolbar. 

5. Click OK. 

6. The Customize dialog box appears. 

7. Click the Commands tab. Click the category that you want to select your button from. Under Commands, 

drag the button that you want to the new toolbar. 

8. Click Close. 

 Steps to delete a custom toolbar 

1. On the View menu, point to Toolbars, and then click Customize. 

2. Click the Toolbars tab. 

3. Under Toolbars, click the custom toolbar that you want to delete, and then click Delete. 
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Operation Sheet 2.3. Database  Fonts 

 Operation title: formatting fonts  

 Purpose: To format fonts  

 Instruction: Using the given application software (ms access) to format a database font. You have given 15 

Minute for the task and you are expected to format fonts 

 

 Tools and requirement: 

1. Personal computer 

2. Microsoft window 

 Step to Change font type 

1. Highlight the text you want to change. 

2. Click the down arrow next to the font field on the format bar. (If 

you want to change the font to bold, italic, or underlined, click 

on the B, I, or U on the format bar.) 

3. After clicking the down arrow for the font, you should be able 

to select from each of the installed fonts on your computer. 

Click the font you want to use and the highlighted text will 

change. 

 

 Step to Change font size 

1. Highlight the text you want to change. 

2. Click the down arrow next to the size box on the format bar. 

Often, the default size is 12, as shown in the above example. 

3. After clicking the down arrow for the size, you should have a 

selection of different sizes to choose. Some fonts may not scale 

properly, so they may have limited size options. 

 Step to Change font color 

1. Highlight the text you want to change. 

2. Click the down arrow next to the color icon. It is usually 

displayed as the letter "A" with a red underline, as shown in the 

example above. 

3. After clicking the down arrow for the color, select the color you 

want to make the text 

 

 Quality Criteria: format fonts 

 Precautions: OHS  

 

 

 

https://www.computerhope.com/jargon/h/highligh.htm
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LAP Test Practical Demonstration 

Name: __________________________                                Date: ____________ 

Time started: ____________________             Time finished: _______________ 

Instruction I: Given necessary templates, tools and materials you are required to perform the following tasks within 

10 hours. 

 

Task-1: make paper size landscape 

Task-2: change the field size of the surname to 20. 
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Unit Three: Forms 

This learning guide is developed to provide you the necessary information regarding the following content coverage 

and topics: 

  Create a simple form 

  Modifying  records  

 Rearranging objects within the form  

This guide will also assist you to attain the learning outcomes stated in the cover page. Specifically, upon completion 

of this learning guide, you will be able to: 

 Create a simple form Using wizard 

 Open existing database and modify  records  

 Order  objects within the form  
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3.1. Create Form using wizard 

1.3.1 Form 

 

A Form is a database object that you can use to create a user interface for a database application. A "bound" form is 

one that is directly connected to a data source such as a table or query, and can be used to enter, edit, or display data 

from that data source. 

Forms are made up of controls, such as text boxes, buttons, document tabs, and drop-down lists, grouped in a way 

that makes them easy to use and helps you get work done. The controls in the form are usually bound, or connected, 

to the tables or queries in your database — but not always. For example, a control that displays your corporate logo 

doesn't have to be bound to a table field. It can just point to the image it displays. In addition to entering data, you 

can use forms in other ways. For example, you can create a form that asks for input, and then generates a custom 

report based on that input. 

In Access  a form is an object that generally serves three purposes: 

 To allow users to perform data entry. Data can be inserted, updated, or  deleted from a table using a Form 

object. 

 To allow users to enter custom information, and based on that information perform a task. For example, 

you may want to ask a user for parameters before running a report. 

 To allow users a method of navigating through the system. For example, you may create a form where a 

user can select a form to load, a report to run, etc. 

Creation of a form by using a wizard is the Ms Access pre-defined way of creating a form by simply following the 

series of steps and choosing which field and format you would want for your Form. 

 

3.2. Modify Records 

Modifying or customizing reports, in many cases, is much the same as modifying or customizing any other form. It 

depends, however, on what type of report you want to modify/customize and whether you want to modify the report 

object or the report criteria form. 

 

 

3.3. Rearranging Objects with in the form 

3.3.1. Object 

A Form object refers to a particular Microsoft Access form. A Form object is a member of the Forms collection, 

which is a collection of all currently open forms. Within the Forms collection, individual forms are indexed 

beginning with zero. 

       Forms are made up of controls, such as text boxes, buttons, document tabs, and drop-down lists, grouped in a 

way that makes them easy to use and helps you get work done.The controls in the form are usually bound, or 

connected, to the tables or queries in your database — but not always. For example, a control that displays your 

corporate logo doesn't have to be bound to a table field. It can just point to the image it displays. In addition to 

entering data, you can use forms in other ways. For example, you can create a form that asks for input, and then 

generates a custom report based on that input. 
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Self check 3 

Test II. Choose 

Instruction: Choose the answer for following question .You is provided 3 minute for each question and each point 

has 5Points. 

1.  is a graphical representation of text  

A. Font 

B. Lay out view 

C. Table 

D. Text 

2. When User wants  to specify or change the appearance of a group of words or characters they needs  

A. Formatting 

B. Deleting 

C. Moving 

D. Copying 

 

 

 

 

 

 

 

 

 

 

 

 



           

Page 34 of 68 
 

Ministry of Labor and 
Skills 

Author/Copyright 

Operate Database Application Version -1 

August, 2022 

 

 

 

 

 

 

 

 

 

Operation sheet 3.1.  Create Form using wizard 

 

 Operation title: customize forms using wizard 

 Purpose: To create simple form by using wizard 

 Instruction: Using the given application software (ms access)to  Create simple forms by using wizard. You 

have given 30Minut for the task and you are expected to create simple forms by using wizards. 

 

 Tools and requirement: 

 

1. Personal computer 

2. Microsoft Window 

 Steps to create a form 

1. Click the Create tab on the ribbon. 

2. Click Form Wizard. 

 
The Form Wizard appears. Anytime you create a form, you must tell Access which table or query you want to use 

for your form 

3. Click the Tables/Queries list arrow and select the table or query you want to use to create your form. 

4. Click the Tables/Queries list arrow and select the table or query you want to use to create your form 
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Now that you have specified the table, you need to tell the Wizard which fields you want to display on the form. To 

add a field to the form, you can either double-click the field or select the field and click the right arrow button 

5. Double-click the fields that you want to appear on the form. 

6. Click Next 

 
Next the Form Wizard asks how you want to lay out the data on the form. There are a few different layout options: 

 Columnar: Displays one record at a time in a format that's easy to read. 

 Tabular: Displays multiple records at a time. 

 Datasheet: Displays multiple records at a time and looks like a table in Datasheet view. 

 Justified: Displays one record at a time. The format usually creates complicated forms that are difficult to 

work with. 

7. Select a layout option and click Next. 

 
8. Enter a title for your form and click Finish 
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 Steps to  save a form 

1. Click the Save button on the Quick Access toolbar. Access saves the form unless you are saving for the 

first time. If you are saving for the first time, the Save As dialog box appears. 

2. Type the name you want to give the form. 

3. Click OK. Access saves the form. You can now access the form by using the Navigation pane. 

 Step to Create a Split Form 

1. In the Navigation Pane, click the table or query that contains the data that you want on 

your form. 

 
4. On the Create tab, in the Forms group, click More Forms, and then click Split Form 

 
The default split form will open as shown below. The Form view is on top of the Datasheet view. However, you can 

change the settings under the form property. 
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 Step to create a multiple items form 

1. Open the Navigation pane. 

2. Click the table or query on which you want to base your form. 

3. Activate the Create tab. 

4. Click Multiple Items in the Forms group. Access creates a multiple items form 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Steps to change the view 

1. Open the form. 

2. Activate the Format tab. 

3. Click the down-arrow under the View button. A menu appears. 

4. Click the view you want. 

 Steps to change the size of a field 

1. Click a side of the field and drag to change the width of the field. 

2. Click the top or bottom of a field and drag to change the height of a field. 

 Steps to move a datasheet 

1. Click the datasheet to select it. 

2. Click and drag the four-sided arrow in the upper-right corner to move the datasheet. 

 Steps to resize a datasheet 

1. Click the datasheet to select it. 

2. Click a side of the datasheet and drag to change the width. 

3. Click the top or bottom of the datasheet and drag to change the height. 

 Steps to apply an AutoFormat 

The AutoFormat option on the Format tab enables you to apply formats quickly, such as background colors, field 

colors, field label colors, and fonts. 

1. Activate the Format tab. 

2. Click AutoFormat. The AutoFormat menu appears. 

3. Click the format you want to apply. 

 Steps to change a form title 

When you create a form, by default, Access uses the form name as the title. You can change the title. 

1. Activate the Format tab. 

2. Click the Title button. 

3. Type the new title. 

 Steps to add the date and time 
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You can easily add the date and time to your form. 

1. Activate the Format tab. 

2. Click the Date and Time button. The Date and Time dialog box appears. Select the date and time format 

you want. The date and time appear on your form. 

Quality Criteria: create form using wizard 

Precautions: OHS   

 

Operation sheet 3.2:  Modify Existing database  

 Operation title: access  Existing database  

 Purpose: To open ad Modify Existing database  

 Instruction: Using the given application software (ms access) to access existing database. You have given 

30Minut for the task and you are expected to open and modify  existing database. 

 Tools and requirement: 

1. Personal computer 

2. Microsoft Window 

 Step to open a database from within Access 

1. Select the File tab to go to Backstage view. 

 

2. Click Open 

 

3. Click Browse. 



           

Page 39 of 68 
 

Ministry of Labor and 
Skills 

Author/Copyright 

Operate Database Application Version -1 

August, 2022 

 

 

4. The Open dialog box will appear. Locate and select the database, then click Open. 

 

 

 

 

 

 Step to create a desktop shortcut to open a database object 

5. Open the database containing the object for which you want to create a shortcut. 

6. Resize the Access window and minimize any other open windows so that you can see the desktop behind 

the Access window. 
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7. In the Navigation Pane, find the object for which you want to create the shortcut. 

8. Drag the object from the Navigation Pane to the desktop. When you release the mouse button, the shortcut 

is created on the desktop. 

9. If you want the shortcut in a location other than the desktop, use Windows Explorer to move the shortcut to 

the location you want. 

Quality Criteria: modify existing Database 

Precautions: OHS   

 

 

Operation sheet 3.3.  Rearranging objects   

 Operation title: Rearrange objects within the form  

 Purpose: To Rearrange objects within the form   

 Instruction: Using the given application software (ms access) to rearrange objects. You have given 

20Minute for the task and you are expected to rearrange objects. 

 Tools and requirement: 

1. Personal computer 

2. Microsoft Window 

 Step to create command button 

1. In Form  Layout view, select the Design tab, then locate the Controls group. 

2. Click the Button command. 

 
3. choose the desired location for the command button, then click the mouse. 

 
4. The Command Button Wizard will appear. In the Categories pane, select the category of button you want to 

add. We want to find a way to move more quickly to specific records, so we'll choose the Record 

Navigation category. 

5. The list in the Actions pane will update to reflect your chosen category. Select the action you want the 

button to perform, then click Next. In our example, we'll choose Find Record. 

 
 

6. You can now decide whether you want your button to include text or a picture. A live preview of your 

button appears on the left. 

7. To include text, select the Text option, then type the desired word or phrase into the text box. 
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8. To include a picture, select the Picture option. You can decide to keep the default picture for that command 

button or select another picture. Click Show All Pictures to choose from another command button icon 

or Browse to choose a picture from your computer. 

 

9. When you are satisfied with the appearance of your command button, click Next. 

10. Type a name for the button. This name won't appear on the button, but knowing the name will help you 

quickly identify the button if you ever want to modify it with the Property Sheet. After adding the button 

name, click Finish. 
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LAP Test Practical Demonstration 

Name: __________________________                                Date: ____________ 

Time started: ____________________             Time finished: _______________ 

Instruction I: Given necessary templates, tools and materials you are required to perform the following tasks within 

10 hours. 

 

Task-1: Create the Navigation Buttons  

 Task-2: Create a label that displays your name 

Task 3. Create a text box  
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Unit Four:  Information Retrieval 

This learning guide is developed to provide you the necessary information regarding the following content 

coverage and topics: 

 Locate Database Records  

 Retrieve information using query  

 Query Developing  

 Data selection 

This guide will also assist you to attain the learning outcomes stated in the cover page. Specifically, upon 

completion of this learning guide, you will be able to: 

 Access existing database and locate required records  

 Create simple query to retrieve information  

 Develop query with multiple criteria  

 Select data and display appropriately 
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4.1. Locate Database Record 

4.1.1. Record in Database 

In a database, a record (sometimes called a row) is a group of fields within a table that are relevant to a specific 

entity. For example, in a table called customer contact information, a row would likely contain fields such as: ID 

number, name, street address, city, telephone number and so on. 

A record in a database is a collection of information organized in a table that pertains to a specific topic or category. 

Another name for a database record is a tuple. A set of records can be referred to as a data set, a data file, and a 

table. The data in the table can come in a variety of forms. It can be numeric, such as an individual's weight or 

financial records related to a company's yearly spending. The data may also include non-numeric information, such 

as an individual's name and a person's job title. 

As your database grows, locating specific records will involve more than a quick glance at a datasheet. In this 

article, learn five ways to locate specific records based on your needs. 

You can browse through records by using the TAB key when you want to move through one record at a time, in 

order, to locate a specific record. You can also browse through records in a table in Datasheet view using the record 

navigation buttons. The record navigation buttons are available at the bottom of the table or form. 

 

Browse through all recordsYou can browse through records by using the TAB key when you want to move through 

one record at a time, in order, to locate a specific record. You can also browse through records in a table in 

Datasheet view using the record navigation buttons. The record navigation buttons are available at the bottom of the 

table or form. 

 

The techniques that you can use to search and filter records are very useful for finding specific records for the case 

at hand. However, you might want to perform the same search or filter operation regularly. Instead of reproducing a 

set of search and filter steps every time, you can create a query. A query is a powerful and flexible way to locate 

specific records because it lets you perform customized searches, apply customized filters, and sort records. You can 

build your own queries to help you focus on specific records and to answer specific questions. Once created, a query 

can be saved and reused, and can also be used in building forms and reports. 

4.2. Retrieve information using query 

4.2.1. Query 

A query is a request for data results, for action on data, or for both. You can use a query to answer a simple question, 

to perform calculations, to combine data from different tables, or even to add, change, or delete table data.  

A query is a derived item in the database meant to answer specific questions that relate to the information in the 

database.  

https://www.techtarget.com/searchoracle/definition/field
https://www.techtarget.com/whatis/definition/table
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It is the means to retrieve relevant information in one or more tables. 

4.2.2. Types of queries 

1. Select Query 

 is the simplest type of query and because of that, it is also the most commonly used one in Microsoft 

Access databases. 

 is the most common type of query.  

 It retrieves data from one or more tables and displays the results in a datasheet where you can update the 

records (with some restrictions).  

 is used to group records and calculate sums, counts, averages, and other types of totals. 

 can be used to select and display data from either one table or a series of them depending on what is 

needed. 

 is the user-determined criteria that tell the database what the selection is to be based on.  

After the select query is called, it creates a "virtual" table where the data can be changed, but at no more than one 

record at a time. 

Action Query 

 are very popular in data management because they allow for many records to be changed at one time 

instead of only single records like in a select query. 

 When the action query is called, the database undergoes a specific action depending on what was specified 

in the query itself.  

 This can include such things as creating new tables, deleting rows from existing ones and updating records 

or creating entirely new ones. 

There are four kinds of Action Query. These are 

 Append Query 

An append query adds a group of records from one or more tables to the end of one or more tables. For example,  

suppose that you acquire some new customers and a database containing a table of information on those customers. 

To avoid typing all this information into your own database, you'd like to append it to your Customers table. 

 Delete Query  

A delete query deletes a group of records from one or more tables. For example, you could use a delete query to 

remove products that are discontinued or for which there are no orders. With delete queries, you always delete entire 

records, not just selected fields within records. 

 Make Table Query  

As the name suggests, it creates a table based on the set results of a query. A make-table query creates a new table 

from all or part of the data in one or more tables. Make-table queries are helpful for creating a table to export to 

other Microsoft Access databases or a history table that contains old records.  

 Update Query  

Allows for one or more field in your table to be updated. 

An update query makes global changes to a group of records in one or more tables. For example, you can raise 

prices by 10 percent for all dairy products, or you can raise salaries by 5 percent for the people within a certain job 

category. With an update query, you can change data in existing tables. 

 Parameter query 

http://www.databasedev.co.uk/delete_query.html
http://www.databasedev.co.uk/make-table-query.html
mk:@MSITStore:C:\Program%20Files\Microsoft%20Office\OFFICE11\1033\acmain11.chm::/html/acrefTypesOfQueriesYouCreateIn.htm
http://www.databasedev.co.uk/update_query.html
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In Microsoft Access, a parameter query works with other types of queries to get whatever results you want. This is 

because, when using this type of query, you are able to pass a parameter to a different query, such as an action or a 

select query.  

It can either be a value or a condition and will essentially tell the other query specifically what you want it to do. 

It is often chosen because it allows for a dialog box where the end user can enter whatever parameter value they 

wish each time the query is run. The parameter query is just a modified select query. 

A parameter query is a query that when run displays its own dialog box prompting you for information, such as 

criteria for retrieving records or a value you want to insert in a field.  

You can design the query to prompt you for more than one piece of information; for example, you can design it to 

prompt you for two dates.  

Access can then retrieve all records that fall between those two dates. 

Parameter queries are also handy when used as the basis for forms, reports, and data access pages.  

4.3. Query Development 

4.3.1.  Query criteria 

A query criterion is an expression that Access compares to query field values to determine whether to include the 

record that contains each value. 

The following tables  shows some sample criteria and explains how they work.  

Table 1. Simple criteria for all data types 

Criteria Name Write it like... Function 

Equals "x" Searches for values equal to x 

Does Not Equal Not in ("x") Searches for all values except those equal to x 

Null Is Null Searches for empty fields 

Not Null Is Not Null Searches for non-empty fields 

Table 2. Simple criteria for text 

Criteria Name Write it like... Function 

Contains Like "*x*" Searches for all values that contain x 

Does Not Contain Not like "*x*" Searches for all values except those that contain x 

Begins with Like "x*" Searches for all values beginning with x 

Ends with Like "*x" Searches for all values ending with x 

Comes After >= "x" 

Searches for all values that come after x in 

alphabetical order. 

Comes Before <= "x" 

Searches for all values that come before x in 

alphabetical order. 

Table 3.Simple criteria for numbers 

Criteria Name Write it like... Function 

Between Between "x" and "y" Searches for values in the range between x and y 

Less Than < x Searches for all values smaller than x 

Less Than or Equal To <= x Searches for all valuessmaller than or equal to x 

Greater Than > x Searches for all values larger than x 

Greater Than or Equal To >= x Searches for all values larger than or equal to x 

Between Between "x" and "y" Searches for values in the range between x and y 

Table 4.Simple criteria for dates 

Criteria Name Write it like... Function 

Between 

Between "#mm/dd/yy#" and 

"#mm/dd/yy#" Searches for dates that fall between two dates. 

Before <#mm/dd/yy# Searches for dates before a certain date 

After >#mm/dd/yy# Searches for dates after a certain date. 

Today =Date() Searches for all records containing today's date 

Days Before Today <=Date()-x Searches for all records containing dates x or more 

mk:@MSITStore:C:\Program%20Files\Microsoft%20Office\OFFICE11\1033\acmain11.chm::/html/acrefTypesOfQueriesYouCreateIn.htm
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days in the past 

   

  

4.4. Data selection 

Data selection is defined as the process of determining the appropriate data type and source, as well as suitable 

instruments to collect data. The primary objective of data selection is the determination of appropriate data type, 

source, and instrument(s) that allow investigators to adequately answer research questions. 

     The function of displaying data is: 

 It is important to display data accurately because it helps in presenting the findings of the research 

effectively to the reader. 

 To make the findings more visible and make comparisons easy 

 Displaying data in research is the last step of the research process.  

 

Self check-4 

Test I. Choose   

Instruction: select the correct answer for the give choice. You have given 1 Minute for each question. Each question 

carries 2 Point 

1………is a collection of information organized in a table that pertains to a specific topic or category. 

A. Record  

B. Query 

C. Font 

2………. is a request for data results, for action on data, or for both. 

A. Table 

B. Query 

C. Database 

3………….. is an expression that Access compares to query field values to determine whether to include the record 

that contains each value. 

A. Simple query 

B. Design 

C. Font 

Test II. 

Instruction: Instruction: select the correct answer for the give choice. You have given 1 Minute for each question. 

Each question carries 2 Point. 

A B 

...........1. Select Query 

 

A. makes global changes to a group of records 

...........2. Update  Query 

 

B. the process of determining the appropriate data type and source 

...........3. Data selection C. derived item in the database 

...........4.Query  

 

D. is used to group records and calculate sums 

 E. Searches for dates after a certain date. 

F. locate Record 

 

 

 

 

Operation sheet-4.1 customize record 

 Operation title: Access &Locate Records   

 Purpose: To access and locate resource   

 Instruction: Using the given application software (ms access) to access and locate records. You have given 

20Minute for the task and you are expected to access and locate reocrds. 
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 Tools and requirement: 

1. Personal computer 

2. Microsoft Window 

 Steps to browse through all records 

You can browse through records from the Datasheet view by using the record navigation buttons at the bottom of the 

table or form. 

1. Go to the first record 

2. Go to the previous record 

3. Current Record box 

4. Go to the next record 

5. Go to the last record 

6. Open a new (blank) record 

7. Filter indicator 

8. Search box 

You can also use the TAB key to move through one record at a time. 

 Steps to Search for a specific record 

1. Open the table or form you want to search. 

2. Click in the field that you want to search 

3. Start the Find command 

 You can either click the Find button in the Find section of the Home tab or press Ctrl+F. 

 The Find and Replace dialog box opens, ready to serve you. 

 

4. Type the text you’re looking for in the Find What box. 

 

 
5. Click Find Next to run your search 

 

 

Quality Criteria: access and locate Resource 

Precautions: OHS   

 

 

Operation sheet-4.2 Creating Simple Query to Retrieve Information 

 Operation title: Query to retrieve information   

 Purpose: To create simple query to retrieve information 

 Instruction: Using the given application software (ms access) to create simple query to retrieve information. 

You have given 20Minute for the task and you are expected to create simple query. 

 

 Tools and requirement: 

1. Personal computer 

2. Microsoft Window 

 Step to create  Query using query Wizard  
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1. In the Database window, click the Create tab on the Ribbon and then click the Query Wizard button from 

the Queries section. 

2. The New Query Wizard dialog box appears, asking you what kind of Query Wizard you want to run. 

Choose Simple Query Wizard and click OK. 

 

 
3. Choose the first table you want to include in the query. 

You'll use the Tables/Queries drop-down menu, which shows all the tables (and any existing queries) in your 

database. Click the down arrow next to the Tables/Queries drop-down menu. Click the name of the table or query to 

include in this query. 

 

 
 

 

4. Select the fields from that table for your query. 

For each field you want included in your query, click the name of the table or query to include in this query, and in 

the Available Fields list, double-click each field from this table or query that you want to include in the query you're 

creating. 

 

 
 

5. After you select all the fields, click Next. 
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6. If the wizard asks you to choose between a Detail and a Summary query, click the radio button next to your 

choice and then click Next. 

7. in the wizard page that appears, select a radio button for what you want to do next 

 
8. Type a title for your query in the text box and then click Finish. 

The wizard builds your query and saves it with the title you entered; then Access displays the results. 

 
 

 

 

 

 

 Steps to create  Query in Design view 

1. Click Query Design from the Create tab in the Ribbon. 
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2. Select each table that you need in the query and click Addto add it to the query. 

Once you've added all the tables you need, click Close to close the dialog box. 

 

3. Add fields. We are in design view 

 

4. Create criteria 
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5. Run the query 

Click ! in the ribbon to run the query 

 

6. Initiate the "Save" Prompt 

Initiate  the ‖save‖ prompt 

 

Name the query 

Provide a name for the query and click OK. 

 

 

 Step to update a query 

1. Click the Create tab on the ribbon. 

2. Click the Query Design button 
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3. Double-click the tables and queries you want to add and click Close 

 

4. Click the Update button.  

5. Click the Update To row for the field you want to update and type an expression. 

6. Click the Run button 

 

7. Click Yes 

 

 

 

 

Quality Criteria: create simple query to retrieve information 

Precautions: OHS   

 

LAP Test Practical Demonstration 

Name: __________________________                                Date: ____________ 

Time started: ____________________             Time finished: _______________ 

Instruction I: Given necessary templates, tools and materials you are required to perform the following tasks within 

2 hours. 

Task-1:Create a Database called EMPLOYEE. Enter the following records, sort table by Employee No. in ascending 

order, save the table as employee. 

 

Employee Name DEPT. DOB Date Employed Qualification 

Ram ICT 20/10/1990 02/01/2010 BCOM 

Gita STORES 12/08/1982 10/05/2012 BED 



           

Page 55 of 68 
 

Ministry of Labor and 
Skills 

Author/Copyright 

Operate Database Application Version -1 

August, 2022 

 

Sita PRODUCTION 16/05/1993 11/04/2015 B.E. 

Rita SALES 17/04/1980 15/03/2016 HM 

Shyam MARKETING 12/01/1989 21/02/2014 BSc 

Prem ICT 11/11/1991 15/10/2014 BED 

a) Create a query that displays all employees with BED and save as query1 

b) Design a query that displays all employees employed before 01/01/2010 or are doing HM. Save as query2. 

c) Print a report that extracts the following information from table: Employee Name and Qualification. 

d) Design a query for those employees who are in the ICT department and their name starts with an 'R'. 
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5.1. Designing reports in a logical sequence  

5.1.1. Report 

 A report is an object in Microsoft Access that is used to display and print your data in an organized manner. Reports 

provide a means of organizing and summarizing data. Reports are often used to present an overview highlighting 

main points and trends. A report can be a simple list, a status report or a monthly production report. A report is made 

from the data available. 

Technique to create report 

 Creating Reports using a wizard Creation of a report by using a wizard is a fastest and easy way to create a 

report by following the series of steps and choosing a pre-defined template for your report.     

 Creating Reports using design view Creation of a report by design view is a user customized way setting-up 

your report so to meet the users desired output and format. 

 

Unit Five:  Reports  

This learning guide is developed to provide you the necessary information regarding the following content coverage 

and topics: 

 Design reports in a logical sequence 

 Modify reports 

 Distribute reports to appropriate person 

This guide will also assist you to attain the learning outcomes stated in the cover page. Specifically, upon completion 

of this learning guide, you will be able to: 

 Design reports in a logical sequence 

 Modify reports 

 Distribute reports to appropriate person 
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When you design a report, you must first consider how you want the data arranged on the page and how the data is 

stored in the database. During the design process, you might even discover that the arrangement of data in the tables 

will not allow you to create the report that you want. This can be an indication that the tables are not normalized — 

this means that the data is not stored in the most efficient manner. 

Make a sketch of your report this step is not required — you might find that the Access Report Wizard or the Report 

tool(both of which are available on the Create tab, in the Reports group) provide a sufficient starting design for your 

report 

Decide which data to put in each report section Each report has one or more report sections. The one section that is 

present in every report is the Detail section. This section repeats once for each record in the table or query that the 

report is based on. Other sections are optional and repeat less often and are usually used to display information that 

is common to a group of records, a page of the report, or the entire report 

Decide how to arrange the detail data Most reports are arranged in either a tabular or a stacked layout, but Access 

gives you the flexibility to use just about any arrangement of records and fields that you want. 

5.1.2. Types of lay out 

Tabular layout    A tabular layout is similar to a spreadsheet. Labels are across the top, and the data is aligned in 

columns below the labels. Tabular refers to the table-like appearance of the data. This is the type of report that 

Access creates when you click Report in the Reports group of the Create tab. The tabular layout is a good one to use 

if your report has a relatively small number of fields that you want to display in a simple list format. The following 

illustration shows an employee report that was created by using a tabular layout. 

Stacked layout    A stacked layout resembles a form that you fill out when you open a bank account or make a 

purchase from an online retailer. Each piece of data is labeled, and the fields are stacked on top of each other. This 

layout is good for reports that contain too many fields to display in a tabular format — that is, the width of the 

columns would exceed the width of the report. The following illustration shows an employee report that was created 

by using a stacked layout. 

Mixed layout    You can mix elements of tabular and stacked layouts. For example, for each record, you can arrange 

some of the fields in a horizontal row at the top of the Detail section and arrange other fields from the same record in 

one or more stacked layouts beneath the top row. The following illustration shows an employee report that was 

created by using a mixed layout. The ID, Last Name, and First Name fields are arranged in a tabular control layout, 

and the Job Title and Business Phone fields are arranged in a stacked layout. In this example, gridlines are used to 

provide a visual separation of fields for each employee. 

Justified layout    If you use the Report Wizard to create your report, you can choose to use a justified layout. This 

layout uses the full width of the page to display the records as compactly as possible. Of course, you can achieve the 

same results without using the Report Wizard, but it can be a painstaking process to align the fields exactly. The 

following illustration shows an employee report that was created by using the Report Wizard's justified layout. 

5.2. Modify report 

Modifying or customizing reports, in many cases, is much the same as modifying or customizing any other form. It 

depends, however, on what type of report you want to modify/customize and whether you want to modify the report 

object or the report criteria form. 

5.2.1. Understand Layout view 
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 Layout view is the most intuitive view to use for report modification, and can be used for nearly all the changes you 

would want to make to a report in Access. In Layout view, the report is actually running, so you can see your data 

much as it will appear when printed. However, you can also make changes to the report design in this view. Because 

you can see the data while you are modifying the report, it's a very useful view for setting column widths, add 

grouping levels, or performing almost any other task that affects the appearance and readability of the report.  

 The report you see in Layout view does not look not exactly the same as the printed report. For example, there are 

no page breaks in Layout view. Also, if you have used Page Setup for format your report with columns, the columns 

are not displayed in Layout view. However, Layout view gives you a very close approximation of the printed report. 

If you want to see how the report will look when printed, use Print Preview. 

 

5.2.2. Understand Design view 

Design view gives you a more detailed view of the structure of your report. You can see the header and footer bands 

for the report, page, and groups. The report is not actually running in Design view, so you cannot see the underlying 

data while working; however, there are certain tasks you can perform more easily in Design view than in Layout 

view. You can: 

 
Figure 12 design view 

 

 

5.3. Distribute Report 

Report is a document containing information organized in a narrative, graphic, or tabular form, prepared on ad hoc, 

periodic, recurring, regular, or as required basis. Reports may refer to specific periods, events, occurrences, or 

subjects, and may be communicated or presented in oral or written form. Liberate your Access reports and distribute 

them far and wide. For example, email them to one or more users, export them to SharePoint document libraries, and 

archive them on network folders.  

When you distribute an Access report, you create a static report of data at a certain moment in time, such as daily, 

weekly, or monthly. By doing so, you have a single point of truth that information workers can use to make good 

business decisions, answer questions, find alternatives, determine best plans, evaluate risks, and improve quality. 

The term "business representative" is often used as a general reference for sales professionals, customer service 

professionals or anyone serving as an interface between customers and a company However, this term has a very 

specific meaning and application in the business world. 

Methods to distribute report 

http://www.businessdictionary.com/definition/document.html
http://www.businessdictionary.com/definition/information.html
http://www.businessdictionary.com/definition/organized.html
http://www.businessdictionary.com/definition/graphic.html
http://www.businessdictionary.com/definition/tabular.html
http://www.businessdictionary.com/definition/form.html
http://www.businessdictionary.com/definition/ad-hoc.html
http://www.businessdictionary.com/definition/required.html
http://www.businessdictionary.com/definition/events.html
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Personalized emails: Segment your email list down to the exact audience that would benefit most from your piece of 

content. Write a custom email to each of these audience members to add a level of personalization to your message. 

Explain what the content is, and why you think he or she will enjoy it.. 

Guest posting: Write an article that discusses -- in a non-promotional way -- the key findings or points within your 

content, and send it to the editor of an online publication that reaches your target audience. But be strategic about it. 

Make sure the publication not only helps you achieve your own reach goals, but also, has something to gain by 

sharing your insights, from your particular brand 

 Follow-up emails: Encourage your sales team to include a link to your content in their follow-up emails to 

prospective clients, to answer their questions and position your company as a resource they can trust.  

 Lead interviews: Work with your sales reps to identify prospective clients you can interview for your 

content. Include a quote in your content, and share it with them once it's published. Not only can that keep 

your leads engaged over time, but they'll appreciate the opportunity to be featured -- and you benefit from 

the additional exposure to their networks when the content is shared with that audience. 

 Proposal references: The best proposals are often supported with relevant data that corroborates the 

solutions you’re suggesting to a prospect. And while we suggest citing a variety of authentic, reliable 

sources -- otherwise, you might look biased -- referencing your own research content can be effective. Not 

only is it another way to distribute your work, but also, it illustrates the time and thought your company has 

invested in this school of thought. 

That said, some prospective clients like proposals to be brief. In these cases, if you preemptively anticipate 

additional questions, you can amend your proposal with a link to the content as a source of further reading and 

information. 

Client drip campaigns 

If your content is related to your clients’ respective industries, or products and services, sharing it with them can 

enhance your collaborations and further nurture that relationship. Remember, it’s called client retention for a reason  

 

 

 

 

 

 

 

 

 

 

 

 

 

Self check 5 

Test I. Choose 
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Instruction:   Answer all the questions listed below. You have given 1 Minute for each question. Each question 

carries 2 Point. 

1------- provide a means of organizing and summarizing data.  

A. Form 

B. Report 

C. Table 

D. All 

2.Which layout uses the full width of the page to display the records as compactly as possible? 

A. Mixed 

B. Justified 

C. A&B 

3---------is the most intuitive view to use for report modification 

A. Layout view  

B. Mixed view 

C. Justified view 

4.Which view gives you a more detailed view of the structure of your report. 

A. Design 

B. Mixed 

C. Justified 

D. none 

5----- is a document containing information organized in a narrative, graphic, or tabular form? 

A. Form 

B. Report 

C. Query 

D. Table 

6.When you distribute an Access report, you create (2) 

A. A static report          C.  mixed view 

B. Normal report           D. justified 

view 

 

 

 

 

 

 

Test II. True/False 

Instruction:   Say True or False the questions listed below. You have given 1 Minute for each question. Each 

question carries 2 Point 

1. Creation of a report by using a wizard is a fastest and easy way to create a report. 

2. Layout view is the most intuitive view to use for report modification. 

3. Reports may  not refer to specific periods, events, occurrences, or subjects, and may be communicated or 

presented in oral or written form. 

           Operation sheet 5.1: Design report 

 Operation title: customize Database report 

 Purpose: To design Database design 

 Instruction: Using the given application software (ms access) to customize database report. You have given 

20Minute for the task and you are expected to design database. 

 

 Tools and requirement: 

1. Personal computer 

2. Microsoft Window 

 Step to Create Reports Using the Report Button 

1. Open the table or query you want to use in your report. We want to print a list of cookies we've sold, so 

we'll open the Cookies Sold query.  

http://www.businessdictionary.com/definition/document.html
http://www.businessdictionary.com/definition/information.html
http://www.businessdictionary.com/definition/organized.html
http://www.businessdictionary.com/definition/graphic.html
http://www.businessdictionary.com/definition/tabular.html
http://www.businessdictionary.com/definition/form.html
http://www.businessdictionary.com/definition/events.html
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2. Select the Create tab on the Ribbon. Locate the Reports group, then click the Report command. 

 
Access will create a new report based on your object 

It's likely that some of your data will be located on the other side of the page break. To fix this, resize your fields. 

Simply select a field, then click and drag its edge until the field is the desired size. Repeat with additional fields until 

all of your fields fit. 

 

 
 

To save your report, click the Save command on the Quick Access Toolbar. When prompted, type a name for your 

report, then click OK. 
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 Step to create a report by using the Report Wizard: 

1. Open the Report Wizard 

 
2. On the Create tab in the Reports group, click Report Wizard. The wizard starts 

 
3. From the Tables/Queries drop-down list, select the table (or query) to base the report on. 

The fields for the selected table load in the Available Fields list box. 

4. Move the fields to include on the report from the Available Fields list box to the Selected 

Fields list box. To do so, double-click a field name to move it or highlight the field 

name and click >. To move all fields at once, click >>. 

 
5. Click Next  

 
6. To group records on the report by a particular field, highlight the field in the list box and 

click. 
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7. Add more grouping levels if desired. You can use the arrows to change the order of the 

grouping levels if needed. 

8. When you finish defining how you want records grouped, click Next 

 
 

Operation sheet 5.2: Switch Report between views 

 Operation title: modifying Report  

 Purpose: To modify  and switch reports between views 

 Instruction: Using the given application software (ms access) to modify and switch reports. You have given 

20Minute for the task and you are expected to modify and switch reports. 

 Tools and requirement: 

1. Personal computer 

2. Microsoft Window  

 

 Step to Modify  report in Layout view 

1. Click the View list arrow on the ribbon and 

select a view option 

 
 

 

 Step to add a field in Layout view 

1. Click the Add Existing Fields button on the ribbon. 

The Field List pane appears and lists the available fields that you can add to the form. 

2. Double-click the field you want to add 
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 Step to Create a new control layout 

1. Click Report in the Reports group on the Create tab. 

2. Click Blank Report in the Reports group on the Create tab, and then dragging a field from the Field List 

pane to the report. 

 Step to create a new control layout by doing the following: 

1. Select a control that you want to add to the layout.  

2. If you want to add other controls to the same layout, hold down the SHIFT key and also select those 

controls. 

3. Do one of the following: 

o On the Arrange tab, in the Table group, click Tabular or Stacked. 

o Right-click the selected control or controls, point to Layout, and then click Tabular or Stacked. 

 Step to Change page setup 

1. Click the Page Setup tab. 

2. In the Page Size group, click Size to select a different paper size. 

3. In the Page Size group, click Margins to make adjustments to the report's margins. 

4. In the Page Layout group, click Portrait or Landscape to change the paper orientation. 

 Step to Change the formatting of a field 

1. Select the field that you want to format. 

2. On the Format tab, use the tools in the Font group to apply the formatting you want. 

 Step to add or modify a logo or other image 

              On the Design tab, in the Header/Footer group, click Logo. 

Browse to the folder where your logo file is stored, and double-click the file. 

 Step to add or edit a report title 

On the Design tab, in the Header/Footer group, click Title. 

A new label is added to the report header, and the report name is entered for you as the report title. 

1. When the label is created, the text in the label is selected for you so that if you want to change the text, you 

can just begin typing the title you want. 

2. Press ENTER when you have finished. 

 Step to add page numbers 

1. On the Design tab, in the Header/Footer group, click Page Numbers. 

2. The Page Numbers dialog box is displayed. 

3. Choose the format, position, and alignment you want for the page numbers. 

4. Clear the Show Number of First Page check box if you do not want a number on the first page. 

5. Click OK. 

 Step to add the date or time 

1. On the Design tab, in the Header/Footer group, click Date and Time. 

2. The Date and Time dialog box is displayed. 

3. Clear the Include Date check box if you do not want to include the date. 

4. If you want to include the date, click the date format you want. 

5. Clear the Include Time check box if you do not want to include the time. 

6. If you want to include the time, click the time format you want. 

7. A sample of the date and time, in the formats you have chosen, appears in the Sample area of the dialog 

box. 

8. Click OK. 

 Step to add line numbers 
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On the Design tab, in the Controls group, click Text Box. 

1. Click in an open area of the section where you want the line numbers to appear. In most cases, this will be 

the Detail section. You will move the text box to its final location later. When you click the report, Access 

creates a new, unbound text box. 

2. Click the label (just to the left of the new text box), and press DELETE. 

3. Click once in the new text box to select it, and then click again to position the cursor in the text box. 

4. Type =1 and then press ENTER. 

5. If the property sheet is not already displayed, press F4 to display it.  

6. On the Data tab of the property sheet, set the Running Sum property to Over All. 

7. Resize the text box to a smaller width by positioning the pointer over the sizing handle on the right edge of 

the text box and dragging it to the left. Leave enough room for the largest line number you expect to see on 

this report. 

8. If needed, make room for the text box on the far left edge of the Detail section by dragging the existing 

controls in that section to the right, or by resizing the leftmost control in that section. 

9. Drag the new text box to the location that you want it on the report. 

10. Switch to Report view, Print Preview, or Layout view to see the line numbers. 

 Quality Criteria: Design Report 

 Precautions: OHS   

 

 

 

 

LAP Test Practical Demonstration 

Name: __________________________                                Date: ____________ 

Time started: ____________________             Time finished: _______________ 

Instruction I: Given necessary templates, tools and materials you are required to perform the following tasks within 

10 hours. 

 

Task-1: Create the Navigation Buttons  

 Task-2: Create a label that displays your name 

Task 3. Create a text box  
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